
 

.01    Where's my mail, man?

If you hear the familiar "you've got mail" sound, choose Read New Mail from the mail menu. 
You must be signed on to AOL to do this. If you've already read the mail, choose Check Mail 
You've Read from the Mail menu. Mail read in this way DOES expire. If a message is important, 
you should save it by clicking the Save to FlashSession button in the lower left corner of the 
window. You can also choose Save from the File menu to save mail as a text file.

If you downloaded your mail via a FlashSession or by using the Save to FlashSession button, 
choose Read Incoming Mail from the Mail menu. This works while online or offline. If the mail 
doesn't show up, and you're using AOL 2.1, it may have been saved as a text file in your Online 
Mail folder. You'll have to open the Online Mail folder and doubleclick the text file.

If you've scheduled outgoing mail in a FlashSession, choose Read Outgoing Mail from the Mail 
menu.

6.02    Where can I get help with mail?

You can choose Mail Gateway from the Mail menu. But wait a second! You can get to the same 
information for free. The trick is to choose Members' Online Support from the Go To menu. The 
click the E-Mail Help icon. To reach the E-Mail Gateway discussion board, doubleclick 
"Sending Mail to the Internet/Other Services". Then click the Message Board icon. This area is 
within Members' Online Support, so it's free!

6.03    How long does mail remain in my mailbox?

From one of America Online's help documents:

"If email has been read, it is deleted 7 days after it was sent. If email is still unread, it remains in 
your mailbox for up to 35 days.

"Note that this means if you read email between 7 and 35 days after it was sent, it will be deleted
shortly after you read it (usually within 24 hours).

You can permanently save email to your hard disk in several ways. While reading mail, choose 
Save from the File menu to save the mail as a text file on your hard disk. Click the Save to 



FlashSession button while reading mail to save it to the Mail file on your hard disk. You can also 
retrieve mail to your hard drive using FlashSessions. To review mail saved as FlashMail, choose 
Read Incoming Mail from the Mail menu.

6.04    Can I cancel a mail message after I send it?

You can, if you have America Online 2.1. There are some restrictions, though. You cannot cancel
a message after it has been read, and you can only cancel mail sent to other AOL members. 
Internet mail, faxes, and U.S. paper mail cannot be canceled. You cannot cancel a message using 
versions of AOL earlier than 2.1.

To cancel a message with AOL 2.1, sign on and choose Check Mail You've Sent from the Mail 
menu. If the message you want to cancel is marked "(not yet read)", select the message and click 
the Unsend button.

You won't always be able to cancel your messages in time. Think twice before sending mail that 
is insulting, threatening, or suggestive. Read the message and apply this acid test: would you say 
the same thing to the person's face? If not, you shouldn't say it in email. 

6.05    How do I know my friends got the mail I sent?

Before sending the mail, you can check the Return Receipt box. When the person reads the mail, 
the system will send you a date- and time-stamped receipt. Personally, I don't use receipts for 
routine mail because I don't want my mailbox filled with the receipts.

Even if you don't use receipts, it's easy to check the status of any mail you've sent in the last two 
weeks. Sign on to America Online, choose Check Mail You've Sent from the Mail menu, select 
the mail, and click the Status button. You'll be told if and when the mail was read.

 



                                The status and receipt functions are AOL features, 
                                not Internet features. They don't work when mail is
                           sent to the Internet. More precisely, they simply
                                tell you when the mail passed through AOL's 
                                Internet mail gateway. This usually happens 
                                a minute or so after you send the mail.

                                You won't receive a receipt if a member uses the
                           Ignore button to ignore your mail without reading it.
                                Likewise, if you check the status of message that was
                                ignored or deleted, you will only be told that it was 
                                ignored or deleted.

6.06    What is cc (carbon copy)?

The cc: field in the mail window is where you type the names of people who should receive 
carbon copies of that message. Carbon copies are a convenient, inexpensive way to broadcast the
same message to many people. Without carbon copies, each copy of the message would have to 
be addressed and mailed separately to each person on a mailing list.

To send carbon copies, enter one name in the To field and enter additional names in the cc field, 
separating each name with a comma.

The coolest use of carbon copies is to send yourself a copy of your mail. Just add your name to 
the cc list. If you retrieve mail with Flash Sessions, you'll have a record of all of your outgoing 
correspondence.

                           The fact that a person has a profile doesn't
                                necessarily mean they're still a member. 
                                Profiles can remain for up to six months after 
                                the person has canceled their account.

                                If you cc a message to a group of people, and one of 
                                those people is no longer a member (or the screen
                           name is misspelled), no one will get that message.
                                It's like the old Christmas lights that were wired
                                in series: when one bulb went out, they all went out.
                                If AOL tells you it can't find one of the people on
                                that list, delete their name from the message and
                                send the message again.



6.07    How do I send blind carbon copies?

If you send someone a blind carbon copy, no one else on the carbon copy list will know that 
person received a copy of the message. Why bother, you ask? By using a blind carbon copy, you 
ensure the recipient's privacy.

To send a blind carbon copy, enclose the person's name with parentheses, like so: (CatFshLuvr). 
To send multiple blind carbon copies, enclose a group of names, separating each name with a 
comma, such as (CatFshLuvr, KittyKitty).

                                You can tell when you've received a blind carbon
                                copy. At the top of the message, below the subject 
                                line, you'll see a line that begins with "bcc:" 
                                and is followed by your screen name.

6.08    What's the difference between Reply and Reply to All?

Reply sends a response only to the person who sent the original message. Reply to All sends a 
response to everyone in the heading, including everyone in the To: cc: lists.

6.09    What is Forward? How do I use Forward to reply to mail?

The Forward command in the mail window allows you to forward messages to other members. 
Click the Forward icon, type in the address you want the mail forwarded to, and type in a 
forward comment. The other person will receive a message with your forward comments, 
followed by the original message. You can't edit the original message.

I often reply to messages by using the forward command. It keeps things in context. The person 
sees my response, followed by their original message.

6.10    What's my AOL mail address?

Your AOL mail address is the same as your screen name. If your screen name is MidNiteBlu, 
your friends on America Online would send email to MidNiteBlu. Nuttin' to it. When people talk 
about their AOL address, they're talking about their screen name, and vice versa.

6.11    What's my Internet mail address?

Your Internet address is of the form screenname@aol.com. If your AOL screen name is "Big 
Tease", your Internet address is "bigtease@aol.com". Spaces are never allowed in Internet 
addresses, so remove any spaces in your name. You should use all lowercase. Some Internet mail
software chokes on uppercase or mixedcase Internet addresses.

Unlike some other online services, AOL doesn't charge extra for sending or receiving Internet 
mail. On AOL, all mail use is charged at normal hourly connect fees.



6.12    How do friends on other services send me email?

The short answer is "have them send mail to your AOL Internet mail address." The long answer 
is "have them send mail to your AOL Internet address using whatever addressing scheme their 
system uses."

Sending Internet mail to AOL is no different from sending Internet mail anywhere else. If your 
friend has an Internet account with a university, corporation, or government agency, have them 
ask their system administrator how to send mail to the Internet. There are many systems, and few
are alike.

If your friend belongs to one of the online services below, no problem. Just tell them to use the 
addressing shown in the table. In these examples, pretend that the mail is being sent to an AOL 
member named "username".

        SERVICE                        AOL INTERNET ADDRESS
______________    _____________________________________________
      AppleLink          username@aol.com@internet#
      AT&T Mail          'internet!aol.com!username'
      Bitnet                username%aol.com@cunyvm
      CompuServe        >INTERNET:username@aol.com
      Connect              username@aol.com
      Delphi                internet"username@aol.com"
      GEnie                  username@aol.com@inet#
      Prodigy              username@aol.com
      SprintMail        (s:internet,"rfc-822":<username(a)aol.com>)

6.13    How do I send email to friends on other services?

You can send email to anyone who has an Internet address. Internet addresses always have the 
Shift-2 "@" symbol in them. If someone has an address like csanders@chicken.com, that's their 
Internet address. Create a new mail message and type that address into the To field of the mail 
window. It's that easy.

If your friend has an account on AppleLink, AT&T Mail, Bitnet, BIX, CompuServe, Connect, 
Delphi, EasyLink, GEnie, or MCI Mail, you're in luck. All of these services have Internet 
gateways, just as AOL does. You'll need to convert your friend's address on the other service into 
a proper Internet address, as detailed in the table below.

    SERVICE              USERNAME                      INTERNET ADDRESS
___________    ______________    ________________________________
 AppleLink          twosteves          twosteves@applelink.apple.com*
 AT&T Mail          !mrwatson          mrwatson@attmail.com**
 Bitnet                bitten                bitten@technion.bitnet
 BIX                      byte                    byte@bix.com
 CompuServe        123456,7890      123456.7890@compuserve.com***
 Connect              thedots              thedots@connectinc.com
 Delphi                psyche                psyche@delphi.com



 EasyLink            62123456            62123456@eln.attmail.com
 GEnie                  aladdin              aladdin@genie.geis.com****
 MCI Mail            1234567              0001234567@mcimail.com*****
 Prodigy              child                  child@prodigy.com******
 The Well            wisher                wisher@well.sf.ca.us

*The AppleLink user must have enabled Internet mail. AOL allows you to abbreviate 
"applelink.apple.com" as "applelink".
**If the username has an exclamation point in front of it, remove the exclamation point. AOL 
allows you to abbreviate "attmail.com" as "att".
***Convert the comma in the user's ID to a period in the Internet address. AOL allows you to 
abbreviate "compuserve.com" as "cis".
****AOL allows you to abbreviate "genie.geis.com" as "genie".
*****Internal MCI Mail addresses are seven numbers. Place three zeroes before the seven 
numbers in the Internet address. AOL allows you to abbreviate "mcimail.com" as "mci".
******All Prodigy members can receive Internet mail. Macintosh Prodigy users can't send 
Internet mail, however.

SprintMail    If your friend uses SprintMail, the addressing is pretty complicated. Have your 
friend send you email. Then copy his or her address into your AOL Address Book.

6.14    What's Rush Limbaugh's Internet address?

70277.2502@compuserve.com. On Compu$pend, send mail to 70277,2502. Rush gets a lot of 
mail, so he may not be able to send a personal reply.

6.15    What's Bill Clinton's AOL address?

ClintonPZ. His Internet address is president@whitehouse.gov. Al Gore's Internet address is 
vice.president@whitehouse.gov. Email is read and compiled by the president's staff members. 
The White House doesn't respond via email, so you'll need to include your postal address if you 
want a reply. Bill gets a lot of mail, so he may not be able to send a personal reply.

Use keyword "white house" or "clinton" to enter the White House Forum on America Online.

6.16 What's Steve Case's AOL address?

SteveCase. Steve being the president and CEO of America Online, Inc. Steve gets a lot of mail, 
so he may not be able to send a personal reply.

If you'd like to leave a suggestion for AOL, use keyword "suggestion".

6.17    How long does it take for my mail to get to other services?

It takes only a few minutes for the mail to pass through the Internet Mail Gateway and reach the 
Internet. From there, the mail passes through various systems before reaching its destination. 

I once sent mail to a listserver in Italy and received an automated reply in just a few minutes. 



That's a round trip across the Atlantic! On the other hand, I once sent mail from my AOL account
to my Internet account at the University of Tennessee, Knoxville. The mail took 26 minutes to 
reach the VAX at UTK. However, that particular VAX is known for its slow mail. Another 
message sent to a UNIX machine at UTK took only a few minutes.

The point of all of this is that once the mail passes through AOL's Internet mail gateway, it's out 
of AOL's hands. That's true of any Internet mail.

6.18    Why is my FlashMail saved as text files?

AOL 2.1 introduced a new preference: Save FlashMail as Text. To change the current setting, 
choose Preferences from the Members menu and then click Mail Preferences. Uncheck the 
option "Save FlashMail as Text".

6.19    Can I broadcast mail to thousands of people?

You can, but thankfully AOL has made it difficult to do so. I say thankfully because mass 
unsolicited mailings rarely benefit the receiver. Mass unsolicited mailings, particularly sales-
oriented mailings, can be considered a violation of the terms of service.

People with something to sell view AOL's membership directory and email as a cheap marketing 
tool. We have to protect ourselves against those intrusions or our email boxes will be as full of 
junk as our paper mail boxes. The last time I received a carbon copied offer to have my 
handwriting analyzed for a fee, I forwarded the message to TOSemail.

There are limits on the number of people one can find with a member directory search, and there 
are limits on the number of names one can place in the To and cc fields. Those limits help 
discourage mass mailings.

Mass mailings aren't necessarily bad. Last Christmas I received a nice message from a 
Maryvillian who wanted to wish his town folk a happy holiday. If you use mailings as 
altruistically as this fellow, you have my blessings.

6.20    How do I send faxes through America Online?

Choose Compose Mail from the Mail menu and type your fax. When you're finished, you have to
fill out the To: field. The proper format is name@fax number. To send a fax to James at 1-800-
123-4567, the address would be james@800-123-4567.

Fax machines tend to make poor-quality printouts. To make your fax more legible, use large 
point sizes and easy-to-read fonts. Courier, Geneva, and Helvetica are especially legible. To 
change the font and font size, highlight the text with your mouse, then select the font and size 
from the bottom of the Edit menu.


